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HOW TO MAKE PATTERNLAND WORK FOR YOU

Patternland Weave Simulator for Windows is a large and powerful program with many
capabilities. Patternland will enable you to design your own drafting setup and to create drafts in
your own preferred style of drafting. Patternland is best known for its flexibility and functionality.
You will want to learn what is important for you and where to turn on the features you need.

This illustrated How-To... Step-By-Step Reference Guide is an attempt to consolidate basic
and special program functions by task to provide a reference for a newcomer or a more
experienced user who may use the program intermittently. It is hoped that this task-oriented
guide will let you learn by doing your own tasks, to provide a hands-on approach for
understanding the program and realizing the pattern behind Patternland’s functions. This guide
attempts to synthesize how the many on/off switches of the program work together to set up the
program and perform the tasks most weavers will want to do. It will also incorporate frequently
asked questions. The tasks are presented in four parts: Introductory Program Tasks How To...,
Core Program Concepts and Tasks How To..., Special Program Concepts and Tasks How To... and
Network Drafting How To... and are in order as the user might encounter them while building a
knowledge of program operation in simple terms. A listing of Patternland and Windows Quick
Keys is placed at the beginning after the Table of Contents.

In this guide the emphasis will be on working with the graphics style tools, like the Pointer,
Pencil, Eraser, and Color Paintbrush, using the Microsoft Windows graphical user interface which
employs the Mouse in either Click or fluid Drawing mode. For fluid Drawing, simply depress the
Left Mouse Button continuously while drawing with the Mouse. Otherwise, in the guide’s step-by-
step instructions Click means Left Mouse Button Click and Right Click means Right Mouse Button
Click. (Keyboard data input is also possible, see Keyboard Data Entry documentation in the
OnLine Help.) Part 1 of this guide will be available to Trial Edition users as supplemental
documentation in the form of a zipped MS Word document that can be downloaded from our web
site. Portions of the guide may be programmed back into the How To... section of the OnLine
Help. More special topics and advanced topics encompassing publication quality printing will be
added in the future. This guide is a work in progress and will be continuously updated as the
program expands and evolves.

If you are upgrading from Patternland Weave Simulator for DOS, you will see many
similarities in terminology. Whether you are upgrading or are a new user, follow the learning path
outlined in the Help by completing the Tutorial and browsing the OnLine Help. Any page in the
OnLine Help can be printed--there are now more than 250 pages--to create your own manual of
important topics. We will continue to expand the OnLine Help as new capabilities are added. If
you are previewing the Trial Edition, browsing the Help and opening some of the library files will
give you a feel for the program. You may also be able to complete the Tutorial, but it was
designed more specifically as a learning tool for the new user. Opening pre-existing files in the
library will let you view different woven drafts, drafting and printing styles, and experiment with
drafting a weaving. See Introductory Program Tasks How To... Use the Program Library.
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PATTERNLAND AND WINDOWS QUICK KEYS

PATTERNLAND QUICK KEYS The following list organizes Patternland Quick Keys with pertinent
Windows Hot Keys that will move you between tasks without having to go through the Main Menu.
The key is displayed with the equivalent menu path. Control+Key means to first hold down on the
control key and then press the other key at the same time.

HELP
F1 — Help/Contents
Control+F1 — F or Help on a Menu Option, Context Sensitive Help

FILE

Alt+F — Jumps you to the File Menu, also a good key to free up a locked cursor and save your
work

AlIt+FS — Jumps you to the File/Save Dialog Box

Control+Click on OK when a Filename is Highlighted in the File Open Dialog Box — Displays the
Title/Artist Information and the file date and size

Control+insert — Saves a highlighted title description or other data in the Title and Artist
Information Dialog to the Windows Clipboard (for use with dialog boxes where the Edit
Menu is inaccessible)

Shift+insert — Pastes title description information from the Windows Clipboard into the Title and
Artist Information Dialog

EDIT

Control+G — Edit/GoTo, moves cursor to desired warp thread & weft treadle-row number or
lift-plan row number and centers the screen.

Control+Home — Moves to the first page of the active weaving/design editor or mini-display.

Contorl+End — Moves to the last page of the active weaving/design editor or mini-display.

Control+Z - Edit/Undo, also Alt+Backspace

Control+X — Edit/Cut

Control+C - Edit/Copy, also Control+Iinsert

Control+V - Edit/Paste, also Shift+Insert

Shift+Control+insert — Edit/Paste Special

Control+A — Edit/Select All, marks or selects all of the active editor’s data in an active window.
(Remember to choose Edit/Copy to save it to the Clipboard after selecting.)

Delete — Edit/Clear

Control+Delete — Edit/Clear Special

DRAFT

Control+U - Draft/Unified Editor, opens the Unified Editor

Control+E — Draft/Selected Editors, opens and cascades independent Editors selected under
Format/Styles

Control+Left, Right, Up and Down Arrow Keys — Scrolls the Page/Screen, or use Paging Tools

Insert Key — Inserts a warp or weft thread; inserts a treadle in the tie-up; and inserts a row in the
Design Editor

Delete Key — Deletes a warp or weft thread; and deletes a treadle in the tie-up

Control+Delete — Deletes a row in the Design Editor

Plus Key — Adds a shaft in the threading or adds a treadle in the treadling (to expand from a
center or anywhere); adds a shaft in the tie-up; and adds a column in the Design Editor

Minus Key — Deletes a shaft in the threading or deletes a treadle in the treadling (to contract from
the center or anywhere); deletes a shaft in the tie-up; and deletes a column in the Design
Editor
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Control+S — Toggles Smart Cursor on and off, or use the Shifter (Gear Shift) Tool when Loom
Controller is off

Right Mouse Button Click on a Color Button — Color/Palette, opens the Windows Custom Color
Palette

Escape Key — Cancel Out of a Dialog Box, Exit a Full Screen Display

DISPLAY

Control+D - Display/Weaving, displays the weaving

F5 — creates a Full Screen Display from a regular Display, cancel out of the Display Status
Window first

Control+M — Window/Refresh Mini-Display, refreshes or resizes the Mini-Display Window, good
for after displaying a weaving as the display temporarily alters the Mini-Display setting

PRINT

Control+W — Print/Print Weaving Preview, creates a displayed Weaving Print Preview

Control+P — Print/Weaving, opens the Print/Weaving Dialog Box to print the weaving

Control+L — Window/Close Editors, closes the Unified Editor or open Editors but leaves the Mini-
Display open

LOOM CONTROL
Click on Shuttle Tool — Activates Loom Control
Click on Shifter Tool (Gear Shift) — Changes Direction when the Loom Controller is On

WINDOW

Control+R — Window/Refresh All

Control+M — Window/Refresh Mini-Display, refreshes or resizes the Mini-Display Window, good
for after displaying a weaving as the display temporarily alters the Mini-Display setting

Control+L — Window/Close Editors, closes the Unified Editor or open Editors but leaves the Mini-
Display open

OTHER WINDOWS HOT KEYS AND TIPS

Alt+Key Letter of Menu — Jumps you to that menu

Printscreen — Saves the entire screen to the Windows Clipboard

Alt+Printscreen (or Shift+Printscreen for some keyboards) — Saves only the active window on the
screen to the Windows Clipboard

Drag (with Left Mouse Button depressed) diagonally across a Screenshot — Marks it for copying
or deleting

Window/Window Number and Title — Click on the Window Number and Title to bring a Window
forward that has gone Behind

F2 - Toggles on or off the Caption Bar of the Active Window
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PART 1
INTRODUCTORY PROGRAM TASKS HOW TO...

FIND AND PRINT HELP

CALL ON-LINE HELP AT ANY MENU OPTION Highlight the menu option desired and press the
Function 1 key or the Help key. You can also Right Click on the right mouse button with any menu
option highlighted. Also, you can enter the OnLine Help under Help at the Main Menu. From any
dialog box, Click on the ? button for Help. From there you can run the Tutorial or look up topics in
the Index. See also Help/Contents/Help System in the OnLine Help.

PRINT ANY PORTION OF THE ON-LINE HELP, INCLUDING THE TUTORIAL AND HOW-TO SECTION
From the Main Menu, choose Help/Contents/Topic Index. You will see every topic in the Help
section listed in alphabetical order. Click on the Topic you want and it will be displayed in a
printable window, maybe several pages long in length. Click on Print to print the entire topic, or
File/Print Topic. The Tutorial, How-To and Getting Started sections use special windows that stay
on top and do not have a File/Print option. These windows are light yellow in color and are the
design of MS Windows hypertext help. They can only be printed by first entering the Topic Index
and then selecting them from the alphabetical listing, like Tutorial: Entering a Draft. They will
appear onscreen in white and can then be printed in the same way as the other topics above.

After you have called up a Topic and printed it, choose Back to take you back to the Topic Index or
go back one step. See also Help/Contents/Help System in the OnLine Help.

USE THE ONSCREEN TUTORIAL Choose Help/Contents and click on Tutorial Contents. The
Tutorial will open from the beginning.

USE THE PROGRAM LIBRARY

OPEN PRE-EXISTING WEAVING FILES IN THE LIBRARY To access the library your file path in
Patternland under File/Open/Weaving should be set to C:\PWSW. This is the standard setting.
Then under File/Open/Weaving double click on the Library subdirectory to bring down the list of
weaving subdirectories which contain weaving files. These subdirectories are organized by the
number of shafts and then weave structure type, like 08twill. This organization works well
because computers sort numbers before alphabetical letters. Then double click on the weaving
subdirectory to see a dropdown list of weaving files displayed and click on the file you want. It
will into the program’s Unified Editor. Meanwhile also in the File Dialog, when the filename is
highlighted press Control and Click on OK to see Title/Artist, file date and size information.

Each weaving .pww file in the library has a matching .psy style file. If you chose File/Open/Style
files you would see them. The weaving file controls the data and palette colors of the weaving,
while the style file controls standard color setups, the format of the editors, and display and print
styles. When you open a weaving file, its style file is automatically loaded with the weaving as a
default depending on your program setup. You can go to Print/Preview Weaving to see the draft
displayed as a printout, with a title line. Choose Cancel, then Draft/Unified Editors to return to the
drafting screen.

You may see more colors used in the weaving than your Colorbar displays. To see all of the

palette colors for each weaving displayed on the Colorbar, go to Program/Colorbar and change
the number of buttons from 16 to 128.
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OPEN PRE-EXISTING COLOR PALETTE AND DESIGN (TAPESTRY-STYLE) FILES IN THE LIBRARY
In the Library there is also a Palette subdirectory containing some sample .pcp palette files. They
are arranged by the number of colors in the palette along with a descriptive name, like 64earth
meaning 64 colors in subtler landscape shades. Some of the weaving file names actually have a
name similar to the color palette they employ. It is fun to play with substituting different color
palettes to see the colors in the weaving change. To open a different color palette and for a
weaving, after you have loaded a weaving file choose File/Open/Colors. Choose the
Library/Palette file path and you should see a number of .pcp palette files. Click on the palette file
you want. Make sure you have expanded your Colorbar to 128 in the step outlined above.

In the Library of version 6.05 there is a Design subdirectory containing some .pwd design files. To
open a design file, first close the editors under Windows/Close Editors. Then choose
File/Open/Design and click on the file you want. Then choose Draft/Design Editor. Follow the
instructions in the section on Drafting a Design under Special Program Concepts and Tasks.

DRAFT A WEAVING

DRAFT A NEW WEAVING IN THE UNIFIED EDITOR When you open the program you will be taken
to the Unified Editor and given a new file, just like requesting File/New. The Unified Editor found
under Draft/Unified Editor (or Control+U) is the joined-together quadrant-style drafting editor,
known also as a composite draft. It is the main editor for creating a draft.

Patternland Weave Simulator for Windows Version 6.05 Screenshot
Draft/Unified Editor Opens the Unified Editor to Draft a Weaving
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The different draft component editors, like Threading, Tie-up, Treadling and the Lift-plan, can be
used independently or selectively (separately by themselves or selected in different groups) which
is a benefit in comparing designs and for copying and pasting. Using an independent editor is
also a benefit for working on one very large threading, for example.

When you enter the program it is the equivalent of choosing File/New. Otherwise, to create a new
draft from the Main Menu choose File/New. To save your work do File/Save and you will be
prompted for the file name and title. To save your weaving file to a new version choose File/Save
As. The program will create a .pww suffix for weaving files. To open an existing file choose
File/Open.

You can set up the weaving’s size, shafts, treadles or lift-plan size, see Set Up the Unified Editor
section below. The Unified and Independent Editors can all be set up in a wide variety of drafting
styles which is also covered in Set Up the Unified Editor section below.

If you are upgrading from PWS DOS, remember in Windows programs the Edit menu option is
reserved for special copy and paste features. Thus, in Patternland Weave Simulator for Windows
(PWSW) the Draft menu option is now the main drafting work zone. The Edit menu is now
reserved for specialized editing features like copy, paste or paste special for symmetrical copying
options.

ACTIVATE AN EDITOR TO USE THE DRAFTING TOOLS In the Unified Editor the editors you have
chosen will come together to form a quadrant-style or composite draft. The highlighted or
outlined editor, like the Threading, Tie-up, Treadling or Lift-plan is the active editor which means it
is ready for data input. Using the Pointer Tool, or the other drawing tools, click within the border
of the editor you want and it will become active; you will see highlighted frame around it. In the
Toolbar at the top of the screen you will see the tools from left to right: the Pointer, Pencil, Eraser,
Marking Tool, Color Paintbrush, Symbol Brush, Shuttle, and Shifter (Gear Shift). The first five are
use most often for drafting. The Pointer will activate the editors, focus a window and help you find
your place, while the Pencil will do those same things plus input data. Click on the Pencil and
either click or fluidly Draw to input data in the Threading, Tie-up, Treadling or Lift-plan.

The Weaving Editor, where the pattern or interlacement forms, will also become active if you click
within its boundary. You can use the Color Paintbrush tool to change colors in the Weaving, but it
is basically the outcome of data input. See the section Use Color below. Also when the Weaving
Editor is active, all or a portion of the interlacement can be marked and copied to the Clipboard.

DRAFTING TOOL TIPS Clicking on the Pencil tool will make it the active tool. You can Click on
each desired square of the graphpaper in an editor or Draw in a fluid motion while continuously
depressing the left mouse button. Depending on whether you like clicking or fluid drawing, under
Format/Unified Editor in the Unified Editor Dialog Gutters section you can increase the Hot Spot to
make fluid drawing smoother.

For ease of use there is a reverse action on the main tools. For example, on the Pencil tool Right
Click acts as the Eraser to make correcting a mistake faster. The Eraser also functions similarly
with the Right Click mouse button reversing roles and acting as the Pencil. And the Color
Paintbrush tool has the same action, Left Click puts in a color while Right Click erases a color.

VIEW THE MINI-DISPLAY AND SEE THE FILENAME The Mini-Display Window is a small thumbnail
distance-view graphics version of the weaving. It will be constantly refreshing itself as you draft
to give you an updated picture of your work. The filename of your draft will be displayed in the
caption Bar of the Mini-Display Window. If your Mini-Display is small and your filename is long,
you can always expand the Mini-Display Window. When your Pointer tool rests on the any portion
of the Mini-Display, the name of the file you are working on will be displayed in the Status Line at
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the base of your screen. Also when the Pointer Tool rests within the Mini-Display, the beginning

and ending of the requested range (portion of the weaving) shown in the Mini-Display is listed on
the left side of the Status Line. If there is no range set, the full weaving will be shown in the Mini-
Display, and the numbers will look like 1>159 : 1>159 for warp and weft.

You can move the Mini-Display by clicking and holding down on the caption bar, then dragging it
to the new location. Or, you can also minimize it. In many ways the Mini-Display (also known as
the Primary Window) is the guardian angel or landlord of your weaving file. Closing the Mini-
Display is like exiting your weaving. Do not close the Mini-Display without first saving your
weaving. In most cases you will be prompted to save your weaving if you have not already done
so. Sometimes when a new file loads over an old file, the Mini-Display will show a brief blend of
both weavings until it refreshes itself. Control+M (Window/Refresh Mini-Display) will refresh the
Mini-Display if it needs to be resized when returning from other tasks, like displaying a weaving.

SCROLL THE PAGE/SCREEN AND FIND YOUR PLACE USING THE STATUS LINE Once you are in
an active editor, meaning the editor has a highlight line around it and is ready to accept input, you
can scroll the screen using the arrow tools at the far right of the Editbar Toolbar: Page Left, Page
Right, Page Up and Page Down. Or you can use the Control Key + Up, Down, Left or Right Arrow
Keys. You can also use the paging tools to page the Mini-Display when it is the active window.

You can rest your Pointer tool on any square in the editor and the warp thread and harness
number or weft thread and treadle number will appear at the bottom left of the Status Line to tell
you where you are. Depending on which editor you are in, these numbers will represent different
things, see Status Line in the OnLine Help. In Windows 95 if you minimize a window, like the Mini-
Display or a Toolbar, they will cover up this area on the Status Line. Remember to drag them over
SO you can see your position numbers.

It is probably best to set up the Unified Editor so that a page is contained on the screen. But if
you set up your Size and Shape Set for the Unified Editor so that your page is larger than the
screen, make sure to use the screen scroll bars in combination with the paging tools to cover all
of your page’s data input. See the section Adjust for Monitor Types and Settings at the end of this
section and Program/Editors in the OnLine Help. Also the Independent Editors, which require less
memory, can be scrolled very fluidly because they do not have the internal paging setup that is
required for the Unified Editor.

SET UP PAGE OVERLAP You can set the amount of overlap to page or scroll the screen under
Format/Unified Editor/Page Overlap. | like 8 when working with 8 to the inch graphpaper
highlights. Seeing where you have been as well as where you are going is important. (See the
illustration below for Format/Unified Editor.)

SET UP THE UNIFIED EDITOR

SET UP THE LIMITS (THE WEAVING SIZE, SHAFT AND TREADLE NUMBERS) To adjust the
editors to the number of shafts you want and the size of the weaving you want, from the main
menu choose Format/Limits. You will see a dialog box giving you a number settings for either the
new file you are creating or an existing file. For example, to set the number of shafts to 24 just
highlight the Shafts box and you can change the existing number by typing in 24. This is where
you can also ask for more treadles, or more warp ends and weft picks to increase the size of your
weaving. Once you have the settings to your liking you must then click on the Change Weaving
button. Then click on OK to exit the dialog box and the editors will resize to your request.
Format/Limits Opens the Limits and Defaults Dialog
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SET UP TIE-UP WITH TREADLING AND/OR LIFT-PLAN Patternland runs both a Tie-up with a

Treadling and a Lift-plan simultaneously as part of its internal calculations. You either one or both
display in the Unified Editors. Choose Format/Styles to set up the tie-up with treadling and/or lift-

plan.

Format/Styles Opens the Format Styles Dialog

Format Styles

Defaults

Data Font

Editors and Data

Warp Weft
Threading Treadling
Tieup Lift Plan
Mumberlines Loom Control

Design

]|

v ]
7]

Under Format/Styles you will see buttons for the Tieup, Treadling and Lift-plan choices. Click on
the Tie-Up, Treadling and Lift-plan buttons one at a time to enter the Style Description Dialog Box

for each one. Then in the Status area select or unselect what you want to show in the Editors,

16




Print Preview or Print areas. See the illustration below under Set Up Multi-Entry in the Editors to
see a Style Description Dialog box. After exiting the dialog boxes, say OK at each step. Then to
clear and change the screen in the main menu under Window choose Close Editors. Then choose
Draft/Unified Editors and you will see the screen in your new format. Your weaving file will still
remain open. Note under Format/Styles the buttons for Warp and Weft set up individual
characteristics of the warp and weft in the Weave Editor or the interlacement pattern formed
during data input.

CHANGE THE DRAFT FORMAT QUADRANT POSITIONS The Format menu holds many of the
controls to change the style of your draft. All four draft quadrant positions are possible, two
drawdown plus two drawup formats. Under Format/Unified Editor/Format in the dialog box
choose one of the four options pictured. Upon exit from the dialog boxes, the screen will change.
A drawup format is how the cloth forms on the loom, and it is a good format to use when working
with computer assisted looms. Setting up the Numberlines under Format/Styles/ Numberlines
with a checkmark by Preview, Print and Display will show you that the draft is perfectly changed,
weft thread 1 will always be at the top or bottom of the weaving and warp thread 1 will always be
at the right or left of the weaving.

Format/Unified Editor Opens the Unified Editor Dialog
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SET UP GRAPHPAPER AND HIGHLIGHT LINES Under Format/Graphpaper select the highlight line
setting you want. You can create any style of graphpaper highlighting and set it for any scale in
Decipoints, Centimeters or Inches. | like highlight lines at every 4th or 8th square. Having
graphpaper off in the Weaving Editor, the actual drawdown or pattern part of the draft, is best if
you like to view an interlacement as you work and for Simulation Mode printouts. But you can
also turn it on there as well. The graphpaper settings are extremely flexible. You can even set up
the graphpaper for only horizontal lines like sheet music in the Threading, a style used by
Interweave Press. (Another combination developed for teaching weaving is the capability to have
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the graphpaper on in the Weaving Editor but to hide the actual weaving data for printing drafting
work sheets for students. For information on that setup, see the section Print the Weaving below.)

Format/Graphpaper Opens the Format Graphpaper Dialog
+ Format Graphpaper

Select Graphpaper in Print, Preview, and Display

_ | Weaving _| Design v| Data
v| ¥erticals in Threading
v Horizontals in Treadling{Liftplan

Select Graphpaper in Editors

_| Weaving v| Design v| Data / Ok

Graphpaper Settings

v¥| Ruler Mode

Grid Lines |

Horizontal Highlight Increment (B

Highlight Lines.

Vertical Highlight Increment 8

SET UP NUMERIC DATA IN THE DRAFT Under Format/Styles click on the Threading, Treadling,
Tie-up and/or Lift-plan buttons for each one to enter the Style Description dialog box for each one
and request Numeric data.

SET UP GRAPHIC DATA IN THE DRAFT Under Format/Styles click on the Threading, Treadling,
Tie-up and/or Lift-plan buttons for each one to enter the Style Description dialog box for each one
and request Graphic data. Graphic data (like a small box of color) is best for color and weave
effect, see Set Up Color and Weave Effect below under Use Color. Graphic data is also best when
displaying or printing a weaving in finer scale. Note under Format/Styles the buttons for Warp and
Weft set up individual characteristics of the warp and weft in the Weaving Editor or the
interlacement pattern formed during data input.

SET UP MULTI-ENTRY IN THE EDITORS Some types of woven drafts, like multiple layered
weaves, are best drafted with multiple treadles in use on one row. Sometimes this is called a
skeleton tie-up. Also network drafts may be created using the Multi-Entry option in the threading
or tie-up as well. To set up for multiple data entry, meaning that each active column in the
threading or each active row in the treadling will accept more than one data element, choose
Format/Styles/Threading or Treadling and in the small Options box make sure that the Multi-Entry
has a checkmark.

Format/Styles/Threading Opens the Style Description: Threading Dialog
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i Style Description: Threading
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CHANGE OR EMBELLISH THE DRAFT

DELETE AND INSERT KEYS To add one or more threads or delete one or more threads with the
Pointer or Pencil point to a thread or treadle row in the treadling and press the Insert or Delete
Keys. One thread will be inserted in the next position or deleted on target. Pressing Insert or
Delete again will continue to add or delete threads. Remember the weaving Limit number is being
changed as well. Deleting or inserting works with all tools except the Marking Tool and the Loom
Control Shuttle.

USE DRAFT/QUICK UTILITIES TO COPY TREADLED-AS-DRAWN-IN AND/OR COLORS Under
Draft/Quick Utilities there are features which allow you to copy areas of pattern and/or color by
warp or weft thread numbers between either the warp or the weft. For example you can copy from
warp to warp, or from warp to weft (better known as Treadled-as-Drawn-In) by thread or treadle
number position. You can also copy color alone. Make sure that you expand your weaving Limits
first to contain what are about to do. Draft/Quick Utilities will also let you Find and Replace or
Exchange data and colors. (See How to... Quick Utilities in the On-Line Help.)

USE EDIT/CUT, COPY, PASTE, PASTE SPECIAL AND DELETE FEATURES The Edit menu
functions similarly to a word processor in that it uses the Windows Clipboard but with some extra
special design features. You can use the features under Edit to make multiple copies, advancing
copies, or symmetrical copies like mirror, flip and rotate 180 degrees. You can also copy and paste
tie-ups between drafts and use Edit/Paste Special to rotate a tie-up 90 degrees. You can delete
areas of data as well.

A general outline of the steps for using Edit/Paste or Paste Special follows:
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1) First click anywhere on the Unified Editor, to make sure the Unified Editor window is active and
not the Mini-Display window. Then make the editor you want to copy data from active by clicking
with the Pointer Tool in the editor’'s window.

2) Use the Marking Tool, or Edit/Select All (Control+A), to mark what you want to copy.

3) Choose Edit/Copy to copy it to the Clipboard.

4) Place the Marking Tool, or the Pointer, on the target where you want the new copy to begin.

5) Choose Edit/Clipboard Options to view, set and optionally save Normal or Special settings

6) Choose Edit/Paste or Edit/Paste Special to make the copy. If you choose Paste Special you will
get to view and reset the Special Clipboard settings, then click OK to exit the Clipboard Options
Dialog box.

Use the Marking Tool to Copy a Section of Threading
for Edit/Paste Special Mirrored Copying
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The Marking Tool can capture a portion of a screen or up to one screenful of data at a time.
Edit/Select All will capture all of the data in an active editor even if there is more than one screen.
If you are using the Marking Tool, click on it to make it active and then click and drag on the range
of threads, or data, you want. Start at one end and draw to the other while depressing the Left
Mouse Button; a slight diagonal works well. But you only need to capture the range of threads or

20



data you want, so a slim rectangle or even a slim bar shape will do the job. When you release the
Left Mouse Button the marked area will show in reverse coloring, like black with white numbers
and it will look like it has been cut with pinking shears. (You can unmark a section by clicking
inside the marked area.) To use Select All choose Edit/Select All. When you click on it the entire
threading, treadling or tie-up, whatever you have chosen as the active editor, will be marked with
the same reverse coloring. Then in either case, use Edit/Copy to load it into the Clipboard. Then
put the Marking Tool or Pointer cursor on the target where you want the new copy to begin. Then
use Edit/Paste or Edit/Paste Special. Your new copy or copies will appear in the Unified Editor.

If the area you want to mark is larger than a screenful, but also smaller than selecting everything
using Edit/Select All, then the fastest way to mark it is to use an Independent Editor. To use an
Independent Editor, choose Windows/Close Editors to close the Unified Editor. Your Mini-Display
will still be there holding your weaving open. Then choose Draft/Treadling Editor.

Draft/Treadling Opens the Independent Treadling Editor for Easy Marking
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Since there is less memory and page setup involved with an Independent Editor, it will scroll
endlessly through your data. You can start marking and it will scroll along with you until you have
grabbed all the data you want to use. Note the illustration above shows that you don’t have to
perfectly mark all data, just the range of data you want. Once you have marked it choose
Edit/Copy, then Windows/Close Editors and re-open the Unified Editor under Draft/Unified. Mark
your target and return to the Edit/ Paste or Paste Special functions.
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You need to have something marked and copied to the Clipboard to use Paste or Paste Special. If
you are using Edit/Paste Special you will always be taken to the Clipboard Options Dialog to view
and reset the settings first. This is the best way to work until you understand how the Clipboard
Options Dialog can be set and saved.

There are two sets or ways to set up and save the Clipboard, as Normal or as Special. Saving the
Clipboard setups will store the settings after you close the program. Otherwise, the setup will be
in effect during your current editing session. Edit/Paste will use the Normal setting you have
established, while Edit/Paste Special will use the Special setting. Edit/Clipboard Options will let
you view and change the settings for Normal and Special without having anything copied into the
Clipboard. The Normal and Special buttons will toggle you between the two sets. The Save as
Normal and Save as Special buttons will save the sets.

Edit/Paste Special Opens the Clipboard Options: Special Dialog
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In the Clipboard Options Dialog upper left under Preservation there are two settings: Insert
Clipping and Overwrite. If Insert is on the Limits, the entire size of the weaving, will be expanded
automatically by the size of the copy. This is the safest setting as you can always clean up extra
blank warp. If Overwrite is on, what happens next is dependent on the position of your cursor
when you make the copy. If you are about to make a copy or multiple copies into a blank space,
make sure the Limits of your weaving will contain what you are about to do or expand them first
under Format/Limits. If your cursor is resting on existing data it will be overwritten by your copy.

Under Edit/Clipboard Options if the Destination box in the dialog is set to Selection if Marked the
copies will be placed either into a marked area or at the cursor’s position. You can set up a
marked area and the program will make as many copies as it can and stuff them into the allotted
space. So this setting is the safest for either copying at a target cursor or into a marked area.
(See the OnLine Help for more detail on the Edit Menu and Edit/Clipboard Options Dialog.)
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USE DRAFT/QUICK UTILITIES FOR REVERSE TIE-UP OR LIFT-PLAN Once you have completed a
draft, to view the other side of the weave or cloth, first make sure that the Tie-up or Lift-plan editor
is active or highlighted in the Unified Editor. Then at the main menu go to Draft/Quick
Utilities/Reverse Tie-up or Lift-plan. With the Tie-up or the Lift-plan active, clicking on Reverse
Tieup will flip the entire weave to the other side, enabling you to view the other side of the cloth.
This feature is also useful to convert drafts from rising shed Jack-type to sinking shed Counter-
balanced looms.

VIEW AND PRINT A FLOAT REPORT Choosing Draft/Quick Utilities/Floats Report will request a
float report on your current weaving. It is a good idea to houseclean your weaving file first making
sure that the limits end where your data ends. If you have a large weaving you may need to wait a
few seconds while Patternland calculates and organizes the information.

Draft/Quick Utilities/Floats Report Opens the Floats Report Dialog
and Allows the User to Generate a Larger Printed Report
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Depending on how it is set up the Floats Report dialog box will present the float report as a
Summary Table screen display. To print out the Summary Table alone, first make sure the Over &
Under is not checked but leave the Summary Table checked. Click on Create Report then click on
Open Report. The report will appear in a Notepad file format. After the Summary Table is
displayed, click on File/Print to print the report.

If you want a Detail Floats Report showing Over and Under float length and location, click on all
the Over and Under boxes and go through the same steps to Create and Open the report. If
Append is checked, each report will add on to the other, creating some duplication. Sometimes
the Detail Floats Report can be quite long so it is a good idea to look at it displayed first before
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you to print it. A file with your weaving’s filename and the suffix .RPT will be created in your
subdirectory.

USE COLOR

OVERVIEW OF COLOR IN PATTERNLAND There are two ways of working with color in
Patternland, with a Palette of colors using a Working Color, or as a pre-selected Single Color.
Knowing where your colors get stored will help you understand how working with color is
organized.

If you are using Palette mode the palette, whether it is the 16 Standard Colors or a larger color
palette you have created, will be saved into either a weaving file or a design file. You can also
open a pre-existing color palette from the library until you are comfortable mixing up your own
and it will be saved with your weaving file. All color palette files have a .PCP file extension. When
using a Working Color with Palette mode the Pencil tool will input color in a painterly manner, for
color and weave effect, and you can use the Color Paintbrush tool to overpaint color on already
existing data. Even in Palette method you can still choose just one color for the warp or one color
for the weft, but the color will be coming from a palette and will be stored in the weaving file.

Single Color mode uses default color settings under Format/Limits initially. You can change the
Single Color for the warp or weft by selecting one from the Windows Custom Color Dialog. Single
colors are stored with the weaving’s style file. All warp or weft will change to your Single Color
and using the Pencil tool to input data will use the Single Color for warp or weft from then on.
This mode will let you concentrate on detailed pattern development while still giving you some
color in the pattern.

You can also use a combination of the two modes, one for warp and the other for weft. For
example, you can use a Working Color with a Palette to do detailed color and weave in the warp,
while you can set up a Single Color for the weft. A file in the library called 128cowv1.pww, under
Library/04Twill is set up this way using Palette with the 128 Color Wheel palette for color and
weave in the warp and Single Color set to black for the weft.

USE THE COLOR PAINTBRUSH TOOL The Color Paintbrush overpaints a Working Color from a
Palette letting you change a color that has already been applied, but it will not input color with
data for the first time. Click on the Color Paintbrush, then the new working color you want and the
Color Paintbrush tool will overpaint with the new color. You can also quickly overpaint color in
the actual weaving pattern, meaning the Weave Editor where the interlacement forms, using the
Color Paintbrush. The Left Mouse Button overpaints warp while the Right Mouse Button
overpaints weft. When the Color Paintbrush is active resting it on any color on the palette will
show the Color Number, like C#36, and its Red, Green & Blue mix in a yellow hints box beside the
color. Left Click chooses a color for overpainting with the working color in the palette appearing
like a punched-in square. In Version 6.05 touching the Color Paintbrush to any portion of the
interlacement of the weaving will display the color numbers of the warp and weft respectively on
the left side of the Status Line. This will look like C#36/C#42 (or Warp Color#/Weft Color#). Even if
the weft is on top its color is in the second position. The Color Paintbrush can help you define
and locate colors which is especially useful if you are working with a large color palette. Right
Click on any color in a palette will open the Windows Custom Color Dialog.

OPEN DIFFERENT COLOR PALETTES Choose File/Open/Colors. Some sample color and gray
palettes reside in the Library under C:\PWSW\LIBRARY\PALETTE. Remember to double click on
Palette to bring up the file listing which contains the suffix .pcp. Choose the color palette you
want. After loading a new color palette, the weaving will change color and this can be a fast and
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fun way to experiment with different color and weave effects. Note that colors will change in the
Weaving even if Numeric data is on in the Threading and Treadling. But remember that under
Format/Styles/Warp and Format/Styles/Weft Palette mode should be on. In some file, Single color
may be on for warp or weft separately, so that color may not change.

USE A WORKING COLOR WITH A PALETTE We will take the long tour of using a Working Color
first to make sure you know where all the switches are located. First under Format/Styles/Warp
and then Format/Styles/Weft, in the Weaving Component Dialog make sure Color Source is set for

Palette and click OK, see the illustration below.

Format/Styles/Warp Opens the Style Description: Warp Dialog
Color Source is set to Palette and Sample displays “Color and Weave”
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Then go to Color/Use Working Color, the second menu option down, and click to turn it on. A
checkmark will appear beside it when it is on. Then choose Color/Working Color, the menu option
at the top, and you will enter the Select Working Color Number Dialog.

Color/Working Color Opens the Select Working Color Dialog



i Select Working Color

Available: 1 to 16
Color #: 13

7] 7|

The Select Working Color Dialog box works well for keyboard data input with color. It allows you
to select a Working Color number from the Colorbar or palette. Enter the color number you want
and click on OK. Then click on the Pencil tool to make it the active tool, and click inside the editor
you want, like the threading editor, to make it active. The Pencil will then input data with the
Working Color and color warp threads will be placed into the Weave Editor.

But you don’t need to go to the Select Working Color Dialog first to work graphically. When Use
Working Color is on under Color/Use Working Color, you can also just click the Pencil tool on the
color you want in the weaving palette to make it the Working Color and input your weaving data
with color. (The Pointer tool will also select a Working Color.) If you go to the Select Working
Color Number Dialog Box it will always show your current working color. Your working color will
also show as a pushed-down color square in the Colorbar or palette.

You can make changes in color by overpainting with the Color Paintbrush. Click on the Color
Paintbrush, then the new working color you want and the Color Paintbrush tool will overpaint with
the new color. The Color Paintbrush won'’t input data with the Working Color for the first time. If
you want to do quick color and weave effect, first input data in one color and then overpaint with
the Color Paintbrush. Remember you can also fluidly draw using the Mouse by continuously
depressing the Left Mouse Button.

You can also quickly overpaint color in the actual weaving pattern, meaning the Weave Editor
where the interlacement forms, using the Color Paintbrush. The Left Mouse Button overpaints
warp while the Right Mouse Button overpaints weft. Using the Color Paintbrush click inside the
Weaving Editor, where the interlacement is, to make it active. You will see a highlight line around
the interlacement area. Click on the color you want and use the Left Mouse Button in either click
or fluid draw to overpaint warp threads or the Right Mouse Button to overpaint weft threads. This
is a fast way to work with color interaction.

Use Working Color can also employ the Windows Custom Color Dialog Box. When Use Working
Color is on, click on Color/Palette to open the Windows Custom Color Dialog. When your Pointer,
Pencil or Color Paintbrush rest on a color in the palette, Right Mouse Button Click will also open
the Windows Custom Color Dialog. You can also use pre-existing color palettes from the Library.
See the sections below on working with the Windows Custom Color Dialog, creating your own
color palettes and opening pre-existing color palettes. (Use Working Color mode is used in the
Design Editor automatically without the user having to turn it on.)

USE SINGLE COLORS FOR WARP & WEFT Single Color mode uses default color settings under
Format/Limits initially. You can change the Single Color for the warp or weft by selecting one
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from the Windows Custom Color Dialog. This mode of working with color will let you concentrate
on detailed pattern development while still giving you a wide choice of color in the pattern.

Fine tuning single colors becomes important when working with color interaction. Using the
Windows Custom Color Palette with its 16-million colors gives you the widest range of choice,
without having to pick a color from a pre-selected palette.

To set up single color editing you will need to choose a single color for warp and weft. Choose
Format/Styles/Warp or Format/Styles/Weft to enter the Style Description: Warp, or Weft, Dialog.
Under Color Source choose the Single radio button, then click on the Single Color button below it.

Format/Styles/Warp Opens the Style Description: Warp Dialog
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Another dialog box will open called Pen and Brush:

Solid radio button, then the Color button below it.

Format/Styles/Warp/Single Color Opens the Pen and Brush: Warp Dialog
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Warp Dialog. Under Brush Style, click on the
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The Windows Custom Color Dialog will open containing the Custom Color Selector.

The Pen and Brush Dialog Color Button Opens the
Windows Custom Color Dialog Box with the Custom Color Selector
Color
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There are three ways to select color from the Windows Custom Color Dialog Box: choose a color
from the 16 Custom Colors, or from the 48 Basic Colors or from the Custom Color Selector, a
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beautiful curtain-like screen of color which reveals and selects color as a mixture of Hue,
Saturation and Luminosity (HSL) as well as a mix of Red, Green and Blue (RGB) light. When you
click on a color in the 16 Custom Colors or in the 48 Basic Colors a highlight frame will surround
your choice. Then click on OK to exit the dialog box and that color will load into Patternland’s
Sample color box. Upon exiting the dialog boxes, your new color choice will be applied to the
warp.

To choose a color from the 16-million-color Custom Color Selector move the cursor to the desired
color area on the screen. Then adjust the Luminosity slider to add or subtract light from your
color and view the Color/Solid box. If you like it click on OK. (See the section below Mix and
Select Colors Using the Custom Color Selector for more detail.) Your new color will appear in
Patternland’s Sample color box. Exiting the dialog boxes will display your new color choice for
either the warp or weft.

Remember to switch back to the Working Color mode under Format/Styles/Warp and
Format/Styles/Weft make sure Single is unselected and Palette is selected.

EXPAND AND RESIZE THE COLORBAR Changing the size and shape of the Colorbar to your
liking is a good first step to creating a larger color palette. | prefer having the color palette look
like a paintbox of square block watercolors. In Patternland this style is called either a Horizontal
Palette or a Vertical Palette. In Horizontal Palette style, Color #1 will be on the left and the
numbering will go across from left to right, while in Vertical Palette style the numbering will go
downward from top to bottom. Also, in a Horizontal or Vertical style palette you can grab the
Colorbar caption bar and drag the window to any position on the screen. Horizontal style with 8
squares to the row works well because the Windows Custom Color Dialog builds a 16 Custom
Color Palette in two rows of 8. Making the color squares a little larger is good for Windows 95
small fonts. To set up this style of palette in preparation for building your own color palette first
choose Program/Colorbar and the Toolbar Setup: Colorbar Dialog Box will appear.

Program/Colorbar Opens the Toolbar Setup: Colorbar Dialog

i Toolbar Setup: ColorBar
Position or Orientation Options
> Top v!| Wrap
~ Bottom _
’ _LEﬂ : v/| Caption Bar
“ Horizontal Palette:
~ Vertical Palette Buttons: [128 | of 512
> Invisible

V 0K annceI ? Help
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On the left turn on the Horizontal radio button; you will see the Top radio button will go off. (The
program comes with Top as the Default.) Then increase the number of Buttons to 128 to build a
128 color palette, 512 is the maximum setting. Under Options; Wrap, Hints and Caption Bar are all
checked. Then click on OK.

When you return to the program you will see your Colorbar in its new Horizontal Palette style and
you can click on its caption bar to drag it to a new location. | like the right side of the screen. To
make the palette into a rectangular shape 8 squares wide, place the Pointer on the right border of
the palette and hold down on the Left Mouse Button. When you see the double arrows, drag the
edge inward while still depressing the button until there are only 8 squares to a row and then
release the Left Mouse Button.

Colorbar Expanded to a Horizontal Palette and Named 128Wheel.pcp

= ColorBar (=[]

You will see the palette become a long thin rectangle eight squares across. To make the palette
larger with squares that are about 3/8” square, position the Pointer on the bottom left hand corner
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and hold down on the Left Mouse Button until you see two diagonally opposing arrows indicating
it is ready to be resized. Hold down on the Shift Key with your left hand and keep depressing the
Left Mouse Button with your right hand (assuming you are right-handed) and drag the corner
down diagonally into a similarly shaped but larger rectangle. When the rectangle is as large as
you want it, release both the Shift Key and the Left Mouse Button. All of the squares should resize
into larger squares. The larger size squares make intricately different colors easier to distinguish
with the eye and grab with the Color Paintbrush. The illustration above is the completed 128 Color
Wheel palette named 128Wheel.pcp found in the program library under Library/Palette.

Once you have resized and made changes to the Colorbar it is a good idea to save these settings
by saving your work as a color palette file. Choose File/Save As/Color and give the color palette
you are about to build a name, like 128First.pcp. Patternland will automatically put the file suffix
of .pcp on the palette file.

CREATE A COLOR PALETTE USING THE WINDOWS CUSTOM COLOR DIALOG Once you have a
palette to fill with colors it is a good idea to clear the screen of other colors as much as possible.
Choose Window/Close Editors to leave the weaving’s Mini-Display primary window on the screen,
even if it is empty. You can move it or minimize it to leave a nice gray screen to work on. Follow
the steps below to create your own palette of colors.

When you look at the Colorbar you will still have the standard 16 color palette showing in the first
16 colors. To access the Windows Custom Color Dialog Box, choose Color/Palette or Right Click
on Color #1, the color at the top left of the palette. Grab the Windows Custom Color Dialog Box’s
Caption Bar and move the window up close to your new color palette so that your color work is
close together on the screen. You will be mixing and selecting 16 colors at a time by gathering
them into the Custom Colors at the base of the dialog box and then loading them into the
Patternland palette. The standard palette of 16 colors will show in the Custom Colors portion of
the dialog box. They first group of 16 colors will be overwritten by your new color selections.
Each group of 16 after that will have new white boxes to fill. (You can always choose colors from
the 48 Basic Colors using the highlight frame and adding them to the Custom Colors, but it is the
new finished Custom Colors that will be loaded into your palette.)

The Windows Custom Color Dialog is a really fun to work with and playing with it will give you
more of the feel of how it works than possibly trying to describe it in words. But when you are
loading colors into a Patternland color palette there are some rules to its behavior that you should
know first. You will be selecting one color at a time and loading it into your new group of 16
Custom Colors.

Rule 1: You are loading 16 new colors in vertical pairs. For a Horizontal Palette Position #1 is top
left and is Patternland Color #1, and Position #2 is below it and will become Patternland Color #9,
Position #3 is next to 1 and will become Patternland Color #2, and Position #4 below it and will
become Patternland Color #10. This is the standard Microsoft Windows format. Patternland color
numbers will still be left to right in the Horizontal Palette, or top to bottom in a Vertical Palette.
Remember the flow of how you want your colors to go, regardless of how you are loading them.

Rule 2: Try to keep an eye on where the highlight frame is. Clicking on a Position #1 in the
Custom Color box places a double dotted highlight frame around it to mark the starting position of
your loading. Once you begin, the frame will become a single solid highlight line and will stay at
the starting place, but the colors will keep loading in vertical pair fashion. You can position it
manually before each selection if you want to be careful. But if you move it manually to touch up
a color it will again become a double dotted highlight frame and will resume loading in vertical
pairs.

Building 16 Custom Colors in the
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Windows Custom Color Dialog Box with the Custom Color Selector
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Rule 3: After selecting a color click on _Add to Custom Colors button and continue doing this until
you are done with all 16 colors. If you click on OK the dialog box will close and load whatever you
have done into the palette. If this happens and you need to return to the dialog box to finish the

16 you are working on, put your pointer on Color #1 again and Right Click with the Mouse. You’'ll
see your unfinished 16 waiting for you in the Custom Colors of the Windows Custom Color Dialog
box.

Once you have completed your first 16, choose OK and the colors will load into the Colorbar
palette. Choose File/Save As/Colors and give your palette a name if you have not already done so.
It is a good idea after each group of 16 to do File/Save/Colors to save your palette. Go to Color
#17 next and Left Mouse Button Click, the gray button will depress and turn white. Patternland will
ask you if you want to define another 16 colors. Click OK and you will be returned to the Windows
Custom Color Palette. Now that you are past overwriting the first 16 colors the Custom Color
boxes will be slightly different shades of white meaning they are ready to be filled. (Windows
keeps track of them individually by the differing shades of white.) Continue the process starting
with Color #33, Color #49, etc. You can always click on a group and it will load them back into the
Custom Colors for further refining or correcting.

MIX AND SELECT COLORS USING THE CUSTOM COLOR SELECTOR The Custom Color Selector
consists of a beautiful curtain-like screen or display box of Hue (predominant spectral color)
played against Saturation (intensity, vividness or purity). In the box Hue stretches from a value of
0 on the left to 239 on the right. The most defined hues on the screen move like a rainbow from
left to right. In the box Saturation stretches from a value 0 at the base to 240 at the top. In the
bottom left corner, both Hue and Saturation are 0 and the muddiest colors will occur there. While
in the upper right corner, both Hue and Saturation are at peak. The most intense and pure hues
reside at the top of the screen. Below, the colors become more indistinct or diffuse, losing
saturation and finally become gray at the base. Grab the box’s cross-hair cursor by clicking and
continuously depressing the Left Mouse Button. Try moving your mouse in small sweeping
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circles. You will see the ColorSolid box change as you do this. Releasing the Left Mouse Button
will pause the cursor and reveal the color area it is resting on.

There is also a long bar with an arrow slider on the side representing Luminosity (tint in
brightness). It will show you the same color your cursor is resting on but with light added and
subtracted to produce tints or shades. You can move the slider up and down to make a final
adjustment to the color in the Color/Solid box. Unless you are looking for extremely light or dark
shades it is best to keep the Luminosity slider in the middle position while you are circling the
display box for a color.

Each color you select in the ColorSolid box will display the Hue, Saturation and Luminosity (HSL)
numbers as well as the Red, Green and Blue (RGB) numbers, equating to your exact mix of color.
You can also select colors using these numbers as well. In Patternland once you have colors
loaded into the palette, clicking on a color with the Color Paintbrush will display a yellow Hints
box which also shows the Color Number’s RGB mix.

SET UP COLOR AND WEAVE EFFECT EDITING Numeric style data input is best for entering
complex patterns and multiple-harness weaves. When the pattern is complete and ready for
complex coloring or for simpler weaves that require applying complex color, it is best to change to
Graphic style input which displays small blocks of color for each individual warp or weft thread.
Under Color click on Use Working Color and a checkmark will appear beside it. Under
Format/Styles/Warp and Format/Styles/Weft click on Palette for Color Source. The Sample Box
should read Color and Weave. Under Format/Styles/Threading and Format/Styles/

Treadling (or Format/Styles/Lift-Plan) choose Graphic, instead of Numeric, and Thread color. The
Sample box which normally displays a Single Color in use should read Color and Weave. Click OK
to leave the dialog box and the appropriate color Graphic squares will replace the threading and
treadling data numbering if data was already in place.

USE COLOR/QUICK UTILITIES TO COPY, FIND AND REPLACE, OR EXCHANGE COLORS The
Draft/Quick Utilities and Color/Quick Utilities have identical color utilities, just placed for easy
access on the two different menus. However, you can use Draft/Quick Utilities to Link Colors with
Data. Using the Colors/Quick Utilities options you can Copy, Find and Replace, or Exchange
colors. You can Copy a section of color in the warp to a section in the weft. If you Link threads
with data, like the threading for example, your treadled-as-drawn-in pattern will have the same
coloring as the warp. This is a good way to copy treadled-as-drawn-in along with color and weave
effect. Beginning with version 6.05 you can Find a Color Number and Replace it with Color
Number 0 (zero), a quick way to clear color in the Design Editor or in a network draft.

Exchange works differently than Find and Replace. In Exchange the program swaps or exchanges
one color for another all at once, in two directions at once, like turning all red to blue and all blue
to red. But Find and Replace allows you more control for more intricate color work like shadow
weave where every other thread is a different color. With Find and Replace you can do the work in
steps, one direction at a time, and change a color to a intermediary color so as not to lose color
detail. For example, first find all red and change them to turquoise, the intermediary color. Then
find all blue and change them to red. Then find all turquoise and change them to blue. Since you
also have control over whether it is doing the work in the warp or weft it is pretty safe. However it
is a good idea to save your work first because you can accidentally change colors so that they
can’t be distinguished and the program won’t be able to undo its actions in this process.

Color/Quick Utilities/Find and Replace Opens the Find and Replace OR Exchange Dialog
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i Find and Replace OR Exchange
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DISPLAY THE WEAVING

DISPLAY A FULL-SCREEN VIEW OF THE WEAVING You can view your weaving as a Display on
your monitor under Display/Weaving or using Control+D. The Display can be set up in a variety of
ways depending on the size and style of graphics you like. The Display forms in a window and
has a Window Control Status Bar at the top. You can click on the Maximize button on the Status
Bar to see a full screen display. Then you can use the paging tools or buttons to move up and
down. You can also choose Cancel on the status bar and press F5 to view the Display full screen.
Press Escape to return to a Window screen. To return to the Unified Editor choose Draft/Unified
or Control+U. Choose Window/Refresh Mini-Display or Control+M to resume the Mini-Display
settings. (See Setup the Display under Core Program Concepts and Tasks.)

ADJUST FOR MONITOR TYPES AND SETTINGS

CHANGE MONITOR SETTINGS Depending on your monitor resolution setting, if you are running
in 640x480 you may want to change the size of the editor’s graphpaper or gridwork. This is done
under Format/Unified Editor/Size & Shape Set/Browse Button. If you need to show more of a
24-shaft threading and tie-up on your screen, experiment with the Decipoint settings by choosing
Spacing 80 by Thickness 60 for example to get your gridworks smaller. | am using the default
settings of Spacing 100 by Thickness 80 while using Windows 95 in Small Fonts mode and in
1024x768 resolution. (See also Program/Editors in the OnLine Help.)
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